LAMPIRAN




Lampiran 1. Silabus Komputer dan Jaringan Dasar KD.3.3

SILABUS MATA PELAJARAN 


Nama Sekolah		: SMK Negeri 1 Gondang
Bidang Keahlian	: Semua Bidang Keahlian
Kompetensi Keahlian	: Semua Kompetensi Keahlian
Mata Pelajaran		: Simulasi dan Komunikasi Digital
Kelas/Semester		: X (Sepuluh) / Gasal
Kompetensi Inti:


KI-3. Memahami, menerapkan, menganalisis, dan mengevaluasi tentang pengetahuan faktual, konseptual, operasional dasar, dan metakognitif sesuai dengan bidang dan lingkup kerja Teknik Komputer dan Informatika pada tingkat teknis, spesifik, detil, dan kompleks, berkenaan dengan ilmu pengetahuan, teknologi, seni, budaya, dan humaniora dalam konteks pengembangan potensi diri sebagai bagian dari keluarga, sekolah, dunia kerja, warga masyarakat nasional, regional, dan internasional.


KI-4. Melaksanakan tugas spesifik, dengan menggunakan alat, informasi, dan prosedur kerja yang lazim dilakukan serta menyelesaikan masalah sederhana sesuai dengan bidang dan lingkup kerja Teknik Komputer dan Informatika. Menampilkan kinerja mandiri dengan mutu dan kuantitas yang terukur sesuai dengan standar kompetensi kerja.Menunjukkan keterampilan menalar, mengolah, dan menyaji secara efektif, kreatif, produktif, kritis, mandiri, kolaboratif, komunikatif, dan solutif dalam ranah.









	Kompetensi Dasar
	Materi Pokok
	Pembelajaran
	JP
	Kegiatan Pembelajaran
	Penilaian

	3.3 Mengevaluasi paragraf deskriptif, argumentatif, naratif, dan persuasif.




4.3 Menyusun kembali format dokumen pengolah kata
	3.3.1 Menganalisis ciri-ciri paragraf deskriptif, argumentatif, naratif, dan persuasif.

3.3.2 Membandingkan paragraf deskriptif, argumentatif, naratif, dan persuasif.

4.3.1 Memanipulasi dokumen menggunakan perangkat lunak pengolah kata.

4.3.2 Membuat tulisan deskriptif.

4.3.3 Mengembangkan proposal menggunakan perangkat lunak pengolah kata.


	· Jenis dan ciri paragraf
· Memformat dokumen menggunakan perangkat lunak pengolah kata
	6
	· Mengamati untuk mengidentifikasi tentang ciri-ciri paragraf berdasarkan karakterisktik melalui contoh tulisan
· Mengumpulkan data tentang fungsi fitur pada perangkat lunak pengolah kata dengan cara memformat tulisan yang belum diformat
· Mengolah data tentang fungsi fitur perangkat lunak pengolah kata dengan cara memformat dokumen yang belum diformat
· Mengomunikasikan gagasan dalam bentuk tulisan deskriptif memanfaatkan perangkat lunak pengolah kata
	Pengetahuan:
· Tes tertulis
Keterampilan:
· Unjuk kerja
· Portofolio





Lampiran 2. Rencana Pelaksanaan Pembelajaran Kelas Kontrol

RENCANA PELAKSANAAN PEMBELAJARAN
(RPP)



	Sekolah		: SMK Negeri 1 Gondang
	Mata Pelajaran	: Simulasi dan Komunikasi Digital
Kelas/Semester	: X/Gasal
	Alokasi Waktu	: 6 x 45  menit 
	



A. Kompetensi Inti
3. Memahami,menerapkan dan menganalisis pengetahuan faktual, konseptual, dan prosedural berdasarkan rasa ingin tahunya tentang ilmu pengetahuan, teknologi, seni, budaya, dan humaniora dalam wawasan kemanusiaan, kebangsaan, kenegaraan, dan peradaban terkait penyebab fenomena dan kejadian dalam bidang kerja yang spesifik untuk memecahkan masalah.
4. Mengolah,  menalar, dan menyaji dalam ranah konkret dan ranah abstrak  terkait dengan pengembangan dari yang dipelajarinya di sekolah secara mandiri, dan mampu melaksanakan tugas spesifik di bawah pengawasan langsung.
B. Kompetensi Dasar
	No.
	Kompetensi Dasar
	Indikator Pencapaian Kompetensi

	3
	3.3 Menentukan paragraf deskriptif, argumentatif, naratif, dan persuasif.

	3.3.1 Menganalisis ciri-ciri paragraf deskriptif, argumentatif, naratif, dan persuasif.
3.3.2 Membandingkan paragraf deskriptif, argumentatif, naratif, dan persuasif.


	4
	4.3 Memformat dokumen pengolah kata
	4.3.1. Memanipulasi dokumen menggunakan perangkat lunak pengolah kata.
4.3.2. Membuat tulisan deskriptif.
4.3.3. Mengembangkan proposal menggunakan perangkat lunak pengolah kata.





C. Tujuan Pembelajaan
Setelah mengikuti proses pembelajaran, diharapkan siswa dapat : 
a. Memahami definisi aplikasi pengolah kata
b. Menjelaskan  fungsi perangkedan ikon yang terdapat dalam perangkat lunak pengolah kata
c. Dapat membedakan perbedaan paragraph deskriptif, argumentative, naratif dan persuasive
d. Dapat membuat karangan deskriptif, argumentatif, naratif, dan persuasive dengan menggunakan
D. Materi Pembelajaran
Materi yang akan dipelajari siswa
a. Definisi aplikasi pengolah kata
b. Fungsi perangkedan ikon yang terdapat dalam perangkat lunak pengolah kata
c. Perbedaan paragraph deskriptif, argumentative, naratif dan persuasive
d. Membuat karangan deskriptif, argumentatif, naratif, dan persuasive dengan menggunakan
E. Model dan Metode Pembelajaran
Metode Pembelajaran	: Presentasi dan tanya jawab
Pendekatan Berpikir	: Teacher Centered Learning
Model Pembelajaran	: Pembelajaran Konvensional
F. Kegiatan Pembelajaran
	KEGIATAN
	DESKRIPSI KEGIATAN
	ALOKASI WAKTU

	Pendahuluan
	1. Salam pembuka  :  Senyum,  salam,  sapa  dan menanyakan kabar siswa, setelah itu mempersilakan ketua kelas untuk memi mpin melakukan doa      menurut agama dan kepercayaan masing-masing sebelum memulai pembelajaran.
2. Mengecek  kesiapan  belajar  siswa,  baju  rapi, lengkap, ruang kelas kondusif, terang, bersih, dan media belajar lengkap.
3. Mempresensi    siswa    satu    per    satu    dan menanyakan apakah siswa lain ada yang tahu keadaan siswa yang tidak masuk.
4. Memberitahukan    tujuan    pembelajaran    di pertemuan hari ini, serta memberi batasan ruang lingkup pelajaran yang akan dibahas.
	10 menit

	Inti

	1. Siswa membaca/mempelajari tentang paragraf deskriptif, argumentatif, naratif, dan persuasif serta prangkat lunak pengolah kata (Mengamati)
2. Siswa diarahkan untuk mempelajari materi mengenai paragraf deskriptif, argumentatif, naratif, dan persuasif serta perangkat lunak pengolah kata dari sumber lain yang relevan dengan sungguh-sungguh dan teliti (Mengamati)
3. Siswa didorong untuk mengajukan pertanyaan yang terkait dengan materi mengenai paragraf deskriptif, argumentatif, naratif, dan persuasif serta perangkat lunak pengolah kata yang telah dipelajari dari buku pegangan siswa maupun dari sumber lain dengan bahasa yang baku dan menunjukkan keseriusan (Menanya)
4. Siswa lain diberi kesempatan untuk menjawab pertanyaan teman yang lain atau memberikan tanggapan atas pertanyaan atau tanggapan teman yang lain (Menanya)
5. Siswa diarahkan untuk melakukan pengembangan proposal menggunakan perangkat lunak pengolah kata, kemudian menuliskan pada LKS yang telah tersedia) (Mencoba)
6. Siswa diminta untuk mengamati hasil diskusi dan praktek, kemudian dengan menggunakan penalarannya, siswa diarahkan untuk membuat kesimpulan yang berhubungan dengan paragraf deskriptif, argumentatif, naratif, dan persuasif serta perangkat lunak pengolah kata (Mengamati, Menalar, komunikasi/jejaring)
7. Dengan Tanya jawab, siswa diarahkan untuk mengemukakan hasil analisisnya yang berhubungan dengan paragraf deskriptif, argumentatif, naratif, dan persuasif serta perangkat lunak pengolah kata  (Menanya, komunikasi/Jejaring)
8. Berdasarkan diskusi,  siswa diarahkan untuk menganalisis paragraf deskriptif, argumentatif, naratif, dan persuasif serta perangkat lunak pengolah kata dan diharapkan siswa berani menyampaikannya di depan teman yang lainnya (Mengamati, Menalar, komunikasi/jejaring)
9. Siswa diberikan soal tentang paragraf deskriptif, argumentatif, naratif, dan persuasif serta perangkat lunak pengolah kata obyek secara individual siswa diminta untuk menyelesaikannya (Menalar, mencoba, komunikasi/jejaring)
· Catatan:
Selama pembelajaran berlangsung, guru mengamati sikap siswa dalam pembelajaran yang meliputi sikap: disiplin, rasa percaya diri, berperilaku jujur, tangguh menghadapi masalah tanggungjawab, rasa ingin tahu, peduli lingkungan)

	160 menit

	Penutup
	· Siswa dengan bimbingan guru, membuat resume tentang paragraf deskriptif, argumentatif, naratif, dan persuasif serta perangkat lunak pengolah kata
· Guru memberikan tugas untuk dikerjakan di rumah

	10 menit




Penilaian
I. Penilaian Hasil Belajar (PHB)
Penilaian Pengetahuan	: Tes Obyektif /Pilihan Ganda (terlampir)
Penilaian Keterampilan	: Penugasan (terlampir)

G. Media/Alat dan Bahan Pembelajaran

Media 	:	LCD Projector, Laptop, Modul PDF
Alat	: 	CD software, spidol, papan tulis







	
Guru Pamong



Heri Krisdiyanto, S. Kom
NIP. 19790914 201001 1 005
	Surakarta, Agustus 2021
Mahasiswa



Tri Mulyati
NIM. K3515057





Lampiran 3. Rencana Pelaksanaan Pembelajaran Kelas Eksperimen

RENCANA PELAKSANAAN PEMBELAJARAN
(RPP)



	Sekolah		: SMK Negeri 1 Gondang
	Mata Pelajaran	: Simulasi dan Komunikasi Digital
Kelas/Semester	: X/Gasal
	Alokasi Waktu	: 6 x 45  menit 
	



A. Kompetensi Inti
3. Memahami,menerapkan dan menganalisis pengetahuan faktual, konseptual, dan prosedural berdasarkan rasa ingin tahunya tentang ilmu pengetahuan, teknologi, seni, budaya, dan humaniora dalam wawasan kemanusiaan, kebangsaan, kenegaraan, dan peradaban terkait penyebab fenomena dan kejadian dalam bidang kerja yang spesifik untuk memecahkan masalah.
4. Mengolah,  menalar, dan menyaji dalam ranah konkret dan ranah abstrak  terkait dengan pengembangan dari yang dipelajarinya di sekolah secara mandiri, dan mampu melaksanakan tugas spesifik di bawah pengawasan langsung.
B. Kompetensi Dasar
	No.
	Kompetensi Dasar
	Indikator Pencapaian Kompetensi

	3
	3.4 Menentukan paragraf deskriptif, argumentatif, naratif, dan persuasif.

	3.4.1 Menganalisis ciri-ciri paragraf deskriptif, argumentatif, naratif, dan persuasif.
3.4.2 Membandingkan paragraf deskriptif, argumentatif, naratif, dan persuasif.


	4
	4.3 Memformat dokumen pengolah kata
	4.3.4. Memanipulasi dokumen menggunakan perangkat lunak pengolah kata.
4.3.5. Membuat tulisan deskriptif.
4.3.6. Mengembangkan proposal menggunakan perangkat lunak pengolah kata.





C. Tujuan Pembelajaan
Setelah mengikuti proses pembelajaran, diharapkan siswa dapat : 
a. Memahami definisi aplikasi pengolah kata
b. Menjelaskan  fungsi ikon yang terdapat dalam perangkat lunak pengolah kata
c. Dapat membedakan perbedaan paragraf deskriptif, argumentatif, naratif dan persuasive
d. Dapat membuat karangan deskriptif, argumentatif, naratif, dan persuasive dengan menggunakan perangkat lunak pengolah kata
D. Materi Pembelajaran
Materi yang akan dipelajari siswa
a. Definisi aplikasi pengolah kata
b. Fungsi ikon yang terdapat dalam perangkat lunak pengolah kata
c. Perbedaan paragrap deskriptif, argumentatif, naratif dan persuasif
d. Membuat karangan deskriptif, argumentatif, naratif, dan persuasif dengan menggunakan perangkat lunak pengolah kata
E. Model dan MetodePembelajaran
Metode Pembelajaran	: Presentasi dan tanya jawab
Pendekatan Berpikir	: Student Centered Learning
Model Pembelajaran	: Pembelajaran Blended Learning dangan Strategi Flipped Classroom
F. Kegiantan Pembelajaran
	PENDAHULUAN
	ALOKASI WAKTU

	· Guru Mengkondisikan Kesiapan Pembelajaran Daring 5 menit sebelum pembelajaran dimulai kemudian memulai kelas dengan mengucapkan salam melalui Group Chat WA Mapel
· Guru Membimbing untuk membaca do’a sebelum pelajaran dimulai.
· Guru mengingatkan peserta didik pentingnya mematuhi protocol covid 19
· Guru Mempersilahkan peserta didik untuk mengisi absen melalui link google form yang telah dipersiapkan https://bit.ly/Absen_siswa_smkn1batealit
· Guru Mengecek kehadiran peserta didik
· Guru Memberi motivasi agar peserta didik tetap semangat dalam mengikuti pembelajaran daring.
· Guru Menjelaskan langkah kegiatan pembelajaran.
Guru menyampaikan tujuan dari pembelajaran.
	

	KEGIATAN INTI
	

	Sintaks
	Kegiatan
	

	Fase-1: Stimulation (Pemberian Rangsangan)
	· Guru Mengajukan pertanyaan yang berkaitan pengoperasian perangkat lunak pengolah kata di Group WA Mapel.
· Guru membagi siswa menjadi beberapa kelompok atau menggunakan kelompok yang telah terbentuk pada pertemuan sebelumnya, kemudian dilanjutkan mengarahkan peserta didik untuk membuka E-learning SMKN 1 Batealit
· Guru Mengarahkan Peserta didik melakukan penelusuran dan mempelajari materi serta video pembelajaran yang telah dibagikan oleh guru pada kelas di e-learning SMKN 1 Batealit
· Guru Memberikan Soal Kasus pada kolom tugas di e- learning, Soal kasusnya Disajikan sebuah format laporan, Bagaimana cara peserta didik Memformat kembali dokumen Laporan tersebut Menggunakan Microsoft Office Word 2013 ataupun WPS office yang telah Terinstall di smartphone peserta didik.
	

	Fase- 2.Problem Statement (Identifikasi Masalah)
	· Guru Memberi kesempatan kepada peserta didik untuk mengajukan pertanyaan melalui Chat di E-learning SMKN 1 Batealit terkait dengan materi yang telah diamati dan di pelajari
Peserta didik Melakukan Analisis dan berdiskusi terkait dengan soal kasus yang ada Melalui Forum diskusi di E- learning dengan bahasa yang sopan dan bertanggung jawab
· Peserta didik diberi kesempatan untuk bertanya berkaitan
· dengan soal kasus yang akan dijawabnya pada kolom chat di E-learning SMKN 1 Batealit.
	

	Fase-3. Data Collection
	· Peserta didik mencari informasi yang berkaitan dengan soal kasus yang ada
· Peserta didik menelaah bahan ajar yang disajikan oleh guru yang berupa materi mupun video yang ada di e- learning.
· Peserta didik memanfaatkan sumber belajar : Bahan Ajar, video pembelajaran dan Internet dalam menggali informasi untuk menyelesaikan kasus soal yang ada.
· Guru melakukan pembimbingan pada saat peserta didik melakukan penggalian informasi untuk menyelesaikan kasus yang ada.
	

	Fase-4. Data Processing (Pengolahan Data)
	· Peserta didik menghimpun informasi yang didapatnya untuk menyelesaikan kasus soal tentang pemformatan laporan.
· Peserta didik dalam Kelompok Membuat format dokumen laporan menggunakan aplikasi pengolah kata dengan benar dan kreatif.
· Guru melakukan pembimbingan pada saat peserta didik melakukan penggalian informasi untuk menyelesaikan kasus yang ada.
· Guru melakukan Observasi dari hasil bertukar pendapat/diskusi yang ada pada group chat kelompok untuk menilai sikap dan ketrampilam peserta didik
	

	Fase-5. Verification (Pembuktian)
	· Peserta didik dalam Kelompok mengumpulkan hasil kerja kelompoknya pada kolom tugas di e-learning
· Peserta didik dalam kelompok Menampilkan hasil Pekerjaannya Melalui zoom meeting, dengan ketentuan penyampaian presentasi maksimal 5 menit.
· Guru Memberikan umpan balik terhadap apa yang telah dikerjakan oleh peserta didik dalam kelompok
· Guru memberikan gambaran jawaban dari soal yang ada dan peserta didik diberi kesempatan untuk membandingkan hasil kerjanya dengan jawaban yang diberikan oleh guru, sehingga semakin menguatkan pengetahuan konsepnya.
	

	Fase-6. Generalization (Kesimpulan)
	· Peserta didik secara bersama-sama menarik kesimpulan dari apa yang telah dipelajari dan dipahami yang dapat dilakukan melalui zoom meeting
· Guru menguatkan kesimpulan yang telah dirumuskan oleh peserta didik
	

	PENUTUP
	

	· Peserta didik ditunjuk untuk menyampaikan Refleksi terhadap pembelajaran yang telah dilakukan melalui Zoom meeting.
· Guru menanggapi Refleksi yang disampaikan oleh peserta didik
· Guru menginformasikan pembelajaran pada pertemuan berikutnya
· Guru mengakhiri pembelajaran dengan salam Melalui zoom meeting
	




Penilaian
I. Penilaian Hasil Belajar (PHB)
Penilaian Pengetahuan	: Tes Obyektif /Pilihan Ganda (terlampir)
Penilaian Keterampilan	: Penugasan (terlampir)

G. Media/Alat dan Bahan Pembelajaran

Media : Internet, Aplikasi WA, E-Learning, Smratphone, Laptop
Sumber Belajar : Internet dan Video Pemformatan Perangkat Lunak Pengolah Kata






	
Guru Pamong



Heri Krisdiyanto, S. Kom
NIP. 19790914 201001 1 005
	Surakarta, Agustus 2021
Mahasiswa



Tri Mulyati
NIM. K3515057





Pertemuan 1

	
Kompetensi Dasar
	
Indikator
	
Indikator Soal
	Jenis

soal
	
soal

	3.5 Menentukan paragraf deskriptif, argumentatif, naratif, dan persuasif.

	3.5.1 Menganalisis ciri-ciri paragraf deskriptif, argumentatif, naratif, dan persuasif.
3.5.2 Membandingkan paragraf deskriptif, argumentatif, naratif, dan persuasif.

	1.   Siswa mampu menjelaskan ciri-ciri paragraf deskriptif, argumentatif, naratif, dan persuasif.
2.   Siswa mampu membandingkan paragraf deskriptif, argumentatif, naratif, dan persuasif.

	Tes

tulis
	1.Jelaskan dan sebutkan ciri-ciri paragraf deskriptif, naratif, argumentatif, dan persuasif ?


2. Buatlah contoh paragraf deskriptif, argumentatif, naratif, dan persuasif.





Pertemuan 2

	
Kompetensi Dasar
	
Indikator
	
Indikator soal
	Jenis

soal
	
Soal

	4.3 Memformat dokumen pengolah kata
	4.3.7. Memanipulasi dokumen menggunakan perangkat lunak pengolah kata.
4.3.8. Membuat tulisan deskriptif.
4.3.9. Mengembangkan proposal menggunakan perangkat lunak pengolah kata.

	1.  Siswa mampu

mengulang kembali membuat paragraf dan mengembangan proposal
	Praktik
	1. Buatlah paragraf dan kembangan paragram tersebut!



KUNCI JAWABAN
PERTEMUAN 1
1. Ciri-ciri dadi berbagai paragraf
a. Paragraf deskriptif
1) Menggambarkan atau melukiskan suatu objek seperti benda, tempat, atau suasana tertentu.
2) Melibatkan panca indra (pendengaran, penglihatan, penciuman, pengecapan, dan perabaan).
3) Menjelaskan ciri-ciri fisik dan sifat objek tertentu seperti warna, ukuran, bentuk, dan kepribadian secara terperinci.
4) Banyak ditemukan kata-kata atau frase yang bermakna keadaan atau kata sifat.
b. Paragraf Argumentasi
1) Berisi pendapat, pandangan, atau keyakinan penulis terhadap suatu permasalahan.
2) Memiliki data-data faktual yang digunakan untuk meyakinkan pembaca.
3) Menjabarkan suatu permasalahan dengan cara menganalisa dan    menganalogikan.
4) Diakhiri dengan kesimpulan berupa pendapat yang lebih luas bukan merupakan penegasan kembali topik utama.
c. Paragraf Naratif
1) Ada tokoh, tempat, waktu, dan suasana yang diceritakan
2) Mementingkan urutan waktu maupun urutan peristiwa
3) Tidak hanya terdapat dalam karya fiksi (cerpen, novel, roman) tetapi juga terdapat dalam tulisan nonfiksi (biografi, cerita nyata dalam surat kabar, sejarah, riwayat perjalanan).
d. Paragraf Persuasif
1) Penulis memahami bahwa pendirian dan pemahaman pembaca dapat diubah.
2) Berusaha menjelaskan dan menarik kepercayaan pembaca
3) Berusaha menciptakan kesepakatan atau penyesuaian melalui kepercayaan antara penulis dengan pembaca.
4) Berusaha menghindari konflik agar kepercayaan tidak hilang dan supaya kesepakatan pendapatnya tercapai.
5) Menunjukkan fakta-fakta dan data untuk menguatkan argumentasi atau dalil
2. Membuat contoh paragraf deskriftif, argumentatif, naratif, dan persuasif
A. Paragraf Naratif –> Menceritakan atau mengisahkan suatu kejadian atau peristiwa sehingga tampak seolah-olah pembaca mengalami sendiri peristiwa itu.

Contoh:
Tepat ketika tanggal 10 Maret, sekolahku libur selama sembilan hari dan akan berakhir pada tanggal 18 Maret. Aku dan seluruh keluargaku tidak menyia-nyiakan waktu ini untuk mengadakan liburan keluarga. Ketika itu aku memilih berlibur ke Pantai Parangtritis. Pagi-pagi aku telah berbenah dan menyiapkan semua perbekalan yang nantinya diperlukan. Sepanjang perjalanan, aku iringi dengan nyanyian lagu riang. Betapa senangnya aku ketika sampai di pantai tersebut. Dengan hati suka ria, aku sambut Pantai Parangtritis dengan senyumku. Pantai Parangtritis, pantai nan elok yang menjadi favoritku. Tanpa menyia-nyiakan waktu, aku mengajak kakakku untuk bermain air. Kuambil air dan aku ayunkan ke mukanya. Dengan canda tawa, kami saling berbalasan. Puas rasanya, terasa hilang semua kepenatan karena kesibukan tiap harinya. Di sana, aku dan seluruh keluargaku saling berfoto-foto untuk mengabadikan momen yang indah ini. Tak terasa waktu berjam-jam telah kuhabiskan disana. Hari pun mulai sore menandakan perpisahan dan kembali pulang. Tak rela rasanya kebahagiaan ini akhirnya selesai. Dalam benakku, aku kan kembali esok.

B. Paragraf Deskriptif –> Menggambarkan sesuatu (objek) secara terperinci atau mendetil sehingga tampak seolah-olah pembaca melihat, mendengar, dan merasakannya sendiri.

Contoh:
Masih melekat di mataku, pemandangan indah nan elok pantai Parang Tritis. Gelombang ombak bergulung-gulung datang silih berganti menyambutku serasa ingin mengajak bermain. Air yang jernih dan pasir putih lembut yang menghampar luas tanpa ada tumbuh-tumbuhan atau karang yang menghalangi membuatku ingin kembali lagi. Di sebelah kanan-kiri, aku bisa memandang air laut sejauh mata memandang, pandai dengan bukit berbatu, pesisir serta pemandangan bukit kapur di sebelah utara pantai. Kurasakan dingin membasuh kakiku karena ombah menghempas kakiku dan terasa asin air itu ketika bibirku terkena percikan. Sepanjang aku berjalan, hampir pinggiran pantai dipenuhi oleh pengunjung wisatawan. Kulihat ada yang berlari berkejar-kejaran di bibir pantai, bermain bola, bermain dengan air, berfoto-foto dengan latar sekitar pantai. Tapi yang paling membuatku tertarik, kulihat ada beberapa turis manca negara yang menikmati keindahan pantai ini dengan naik delman. Seperti apa yang aku lihat, pantai ini memang sangat ramai pengunjung. Tak pernah sunyi pantai Parang Tritis.


D. Paragraf Argumentasi –> mengungkapkan ide, gagasan, atau pendapat penulis dengan disertai bukti dan fakta

Contoh:
Pantai Parangtritis memang memiki keindahan eksotis yang membuat wisatawan ramai berkunjung, tetapi juga sering menelan korban. Yang disayangkan, sebagian masyarakat Indonesia masih saja menganggap peristiwa tersebut berkaitan dengan hal-hal mistis, yakni dikarenakan Ratu Pantai Selatan meminta tumbal. Padahal, ada penjelasan ilmiah di balik musibah tersebut. Para praktisi ilmu kebumian menegaskan bahwa penyebab utama hilangnya sejumlah wisatawan di Pantai Parangtritis, Bantul, adalah akibat terseret rip current. Dengan kecepatan mencapai 80 kilometer per jam, arus balik tidak hanya kuat, tetapi juga mematikan. Jadi, banyaknya korban tenggelam tidak ada kaitannya sama sekali dengan anggapan para masyarakat. Ali Susanto, Komandan SAR Pantai Parangtritis, juga menambahkan bahwa disepanjang Pantai Parangtritis juga banyak terdapat palung (pusaran air) yang tempatnya selalu berpindah-pindah dan sulit diprediksi. Kondisi inilah yang sering banyak menimbulkan korban mati tenggelam.

E. Paragraf Persuasif –> karangan yang bertujuan untuk meyakinkan dan membujuk seseorang agar melakukan sesuatu yang dikehendaki penulis.

Contoh:
Pantai Parangtritis memang memiki keindahan eksotis yang membuat wisatawan ramai berkunjung, tetapi juga sering menelan korban. Yang disayangkan, sebagian masyarakat Indonesia masih saja menganggap peristiwa tersebut berkaitan dengan hal-hal mistis, yakni dikarenakan Ratu Pantai Selatan meminta tumbal. Padahal, ada penjelasan ilmiah di balik musibah tersebut. Para praktisi ilmu kebumian menegaskan bahwa penyebab utama hilangnya sejumlah wisatawan di Pantai Parangtritis, Bantul, adalah akibat terseret rip current. Dengan kecepatan mencapai 80 kilometer per jam, arus balik tidak hanya kuat, tetapi juga mematikan. Jadi, banyaknya korban tenggelam tidak ada kaitannya sama sekali dengan anggapan para masyarakat. Ali Susanto, Komandan SAR Pantai Parangtritis, juga menambahkan bahwa disepanjang Pantai Parangtritis juga banyak terdapat palung (pusaran air) yang tempatnya selalu berpindah-pindah dan sulit diprediksi. Kondisi inilah yang sering banyak menimbulkan korban mati tenggelam. Oleh karena itu, selayaknya warga masyarakat tidak lagi percaya hal-hal gaib dan bisa mengedepankan penalaran logika atau akal sehat. Pemerintah daerah pun sebaiknya memberikan pemahaman yang benar mengenai penyebab bencana laut kepada warga di sekitar pantai. Informasi tersebut dapat diteruskan kepada wisatawan guna meningkatkan kewaspadaan mereka.


Penskoran Jawaban dan Pengolahan Nilai :
Nilai 4 : jika sesuai kunci jawaban dan ada pengembangan jawaban
Nilai 3 : jika jawaban sesuai kunci jawaban
Nilai 2 : jika jawaban kurang sesuai dengan kunci jawaban
Nilai 1 : jika jawaban tidak sesuai dengan kunci jawaban

Pengolahan Nilai
Skor maksimal setiap soal : 4
Total Skor : 8
Nilai : Σ (skor setiap soal) x 100 / 8 = 100

PERTEMUAN 2
Membuat Paragraf dan mengembangkan
A. Alat dan Bahan
1. Naskah digital yang berisikan data berupa teks
2. Komputer yang telah terinstal Aplikasi Microsoft Word

B. Langkah Kerja
1. Siapkan naskah digital yang berisikan data berupa teks
2. Buka Aplikasi Microsoft Word, caranya klik Start  All Programs  Microsoft Office  Microsoft Word. Atau bisa juga Double klik pada icon Microsoft Word yang terdapat pada Dekstop
NASKAH DIGITAL 1
3. [image: ]Ketikan seperti Naskah Digital 1 berikut ini :

4. Untuk membentuk teks seperti diatas bisa menggunakan Tab Home. Font untuk memilih jenis huruf yang diinginkan, Font Size untuk menentukan ukuran huruf. Bold, Italic dan Underline digunakan untuk menebalkan, memiringkan dan memberikan garis bawah pada teks. Strikethrought untuk memberikan garis pada tengah huruf pada teks yang terpilih. Subscript dan Superscript yang digunakan untuk membuat teks dibawah atau diatas sebuah teks terpilih. Text Highlight Color digunakan untuk memberikan efek seperti diberi penanda stabilo. Font Color digunakan untuk menentukan warna pada teks.
5. Fitur yang digunakan untuk membentuk teks seperti diatas adalah Center untuk membuat paragraf rata kanan. Align Text Left untuk membuat paragraf rata kiri, Align Text Right untuk membuat paragraf rata kanan. Justify untuk membuat paragraf rata kanan dan kiri, Numbering digunakan untuk membuat penomoran secara otomatis.

NASKAH DIGITAL 2

6. Gunakan teks pada Naskah Digital 1 kemudian rubah menjadi Naskah Digital 2
[image: ]
[image: ]
7. Untuk membentuk teks seperti diatas bisa menggunakan Tab Insert. WordArt untuk menyisipkan atau membuat tulisan dengan desain yang bervariasi dengn gaya artistis. Drop Cap membuat huruf pertama pada sebuah paragraf menjadi kapital dan lebih besar dibandingkan dengan teks lainnya.
8. Fitur yang digunakan untuk membentuk teks seperti diatas adalah Table untuk menyisipkan tabel pada lembar kerja. Picture untuk menyisipkan gambar pada lembar kerja. Shapes untuk menyisipkan berbagai objek shape atau berbagai jenis bentuk pada lembar kerja. SmartArt digunakan untuk menyisipkan objek struktur organisasi, flowchart dan lainnya pada lembar kerja
9. Gunakan teks Naskah Digital 1 kemudian sesuaikan Pengatuan Lembar Kerja menggunakan Tab Page Layout  Margins  Custom Margins sehingga pengaturan kertas menjadi seperti berikut ini :
Batas atas 3 cm		batas kanan 3 cm
Batas bawah 3 cm		batas kiri 3 cm
10. Kemudian atur orientasi kertas menjadi Portrait dengan cara klik Tab Page Layout
 Orientation  Portrait
11. Merubah ukuran kertas menjadi ukuran A4 dengan cara klik Tab Page Layout 
Size  pilih A4
12. [image: ]Setelah pengaturan lembar kerja diatas sudah teratur, langkah selanjutnya adalah membuat Naskah Digital 1 menjadi Naskah Digital 3 seperti berikut ini :

13. Untuk membuat tulisan seperti diatas, pada menu Page Layout  Columns  Two.
14. Selesai




MATERI

PERTEMUAN 1

Paragraf Deskriptif, Agumentatif, Naratif, dan Persuasif 
A. Paragraf Deskriftif
Paragraf deskriptif adalah sebuah paragraf yang menggambarkan atau melukiskan sebuah objek tertentu melalui kata-kata yang bisa merangsang panca indera sehingga pembaca seolah-olah melihat atau merasakan sendiri benda objek yang dideskripsikan oleh penulis.
Ciri ciri paragraf deskriptif
a. Menggambarkan atau melukiskan suatu objek seperti benda, tempat, atau suasana tertentu.
b. Melibatkan panca indra (pendengaran, penglihatan, penciuman, pengecapan, dan perabaan).
c. Menjelaskan ciri-ciri fisik dan sifat objek tertentu seperti warna, ukuran, bentuk, dan kepribadian secara terperinci.
d. Banyak ditemukan kata-kata atau frase yang bermakna keadaan atau kata sifat.
Jenis Paragraf Deskripsi :
1) Deskripsi Spatial
Paragraf ini menggambarkan atau melukiskan suatu objek yang berupa ruang atau tempat.
2) Deskripsi Subjektif
Paragraf ini berisi gambaran atau lukisan objek yang didasarkan tafsiran atau kesan perasaan penulisnya. Penulis menggambarkan objek tersebut dengan opini atau kesan pribadinya.
3) Deskripsi Objektif
Deskripsi objektif adalah suatu paragraf yang menggambarkan atau melukiskan suatu objek tertentu secara apa adanya sehingga pembaca dapat membayangkan keadaan yang sebenarnya pada objek tersebut. Paragraf ini tidak disertai dengan opini atau kesan penulis.
B. Paragraf Argumentasi
Paragraf argumentasi adalah sebuah paragraf yang gagasan utamanya dikembangkan dengan cara menjabarkan pendapat, ulasan, bahasan, atau ide pribadi penulisnya. Tujuan dari paragraf ini adalah untuk menyakitkan, atau mempengaruhi pembaca agar memiliki pendapat yang sama dengan pendapat penulis.
Ciri-ciri Paragraf Argumentasi
a. Berisi pendapat, pandangan, atau keyakinan penulis terhadap suatu permasalahan.
b. Memiliki data-data faktual yang digunakan untuk meyakinkan pembaca
c. Menjabarkan suatu permasalahan dengan cara menganalisa dan menganalogikan.
d. Diakhiri dengan kesimpulan berupa pendapat yang lebih luas bukan merupakan penegasan kembali topik utama.
Jenis-jenis Paragraf Argumentasi:
1) Paragraf Argumentasi Sebab-Akibat
Paragraf ini diawali dengan pendapat-pendapat yang berupa sebab-sebab dari suatu permasalahan tertentu yang pada akhirnya diarahkan pada satu kesimpulan umum yang disebut juga dengan akibat dari sebab-sebab tersebut.
2) Paragraf Argumentasi Akibat-Sebab
Paragraf argumentasi ini diawali dengan pendapat-pendapat yang berupa akibat dari suatu permasalahan tertentu dan pada bagian akhir paragraf dijabarkan apa yang menjadi penyebab akibat-akibat tersebut.
C. Paragraf Naratif
Paragraf naratif adalah jenis karangan yang mengungkapkan suatu kisah, peristiwa, atau pengalaman pribadi berdasarkan urutan-urutan kejadian atau peristiwa. Paragraf naratif merupakan paragraf yang berisi tentang pemaparan suatu kejadian yang dirangkai dalam kesatuan waktu.
Ciri-ciri Paragraf Naratif:
a. Ada tokoh, tempat, waktu, dan suasana yang diceritakan
b. Mementingkan urutan waktu maupun urutan peristiwa
c. Tidak hanya terdapat dalam karya fiksi (cerpen, novel, roman) tetapi juga terdapat dalam tulisan nonfiksi (biografi, cerita nyata dalam surat kabar, sejarah, riwayat perjalanan).
Jenis-jenis Paragraf Naratif:
1)  Paragraf Naratif Urutan Waktu
Paragraf naratif urutan waktu menonjolkan sisi urutan waktu terjadinya peristiwa. Hal ini sering disebut dengan istilah kronologi.
2) Paragraf Naratif Urutan Tempat Kejadian
Paragraf naratif urutan tempat menonjolkan tempat atau lokasi terjadinya peristiwa.
D. Paragraf Persuasif
Paragraf persuasif adalah paragraf yang isinya berusaha untuk merebut perhatian pembaca. Paragraf ini disajikan secara menarik, meyakinkan mereka bahwa pengalaman yang disiratkan itu merupakan suatu hal yang amat penting. Karena itu, terkadang paragraf persuasi sering digunakan sebagai paragraf propaganda oleh lembaga kesehatan, pemerintah, dan lain-lain.
Ciri-Ciri Paragraf Persuasif:
a. Penulis memahami bahwa pendirian dan pemahaman pembaca dapat diubah.
b. Berusaha menjelaskan dan menarik kepercayaan pembaca
c. Berusaha menciptakan kesepakatan atau penyesuaian melalui kepercayaan antara penulis dengan pembaca.
d. Berusaha menghindari konflik agar kepercayaan tidak hilang dan supaya kesepakatan pendapatnya tercapai.
e. Menunjukkan fakta-fakta dan data untuk menguatkan argumentasi atau dalil
Jenis-jenis Paragraf Persuasif:
1) Persuasi politik
Sesuai dengan namanya, persuasi politik dipakai dalam bidang politik oleh orang-orang yang berkecimpung dalam bidang politik dan kenegaraan. Para ahli politik dan kenegaraan sering menggunakan pesuasi jenis ini untuk keperluan politik dan negaranya. Kita akan bisa memahami persuasi politik lebih baik lagi, bila kutipan berikut ini kita kaji dengan teliti. Naskah persuasi politik berikut ini berkombinasi dengan eksposisi.
2) Persuasi pendidikan
Persuasi pendidikan dipakai oleh orang-orang yang berkecimpung dalam bidang pendidikan dan digunakan untuk mencapai tujuan-tujuan pendidikan. Seorang guru, misalnya, bisa menggunakan persuasi ini untuk mempengaruhi anak supaya mereka giat belajar, senang membaca dan lain-lain. Seorang motivator atau inovator pendidikan bisa memanfaatkan persuasi pendidikan dengan menampilkan konsep-konsep baru pendidikan untuk bisa dilaksanakan oleh pelaksana pendidikan. Kutipan artikel berita ini dapat dijadikan bahan menelaah karangan persuasi pendidikan.







PERTEMUAN 2

MENGOPERASIKAN MICROSOFT WORD 2010
Sebelum memulai Microsoft Word, terlebih dahulu mengecek komputer apakah program Microsoft Word 2010 ini sudah terinstal atau belum. Jika sudah terinstal, anda bisa menggunakannya untuk berbagai keperluan.
Membuka Microsoft Word 2010
1. START --> All Programs --> Microsoft Office --> Microsoft Word 2010
Atau
2. Double klik Icon Microsoft Word 2010 di Desktop
Tampilan Awal Aplikasi
Aplikasi Ms Word 2010 akan tampil saat mengerjakan cara diatas. Tampilan Ms. Word 2010 sangat mudah dipahami. Perhatikan gambar berikut ini

[image: https://1.bp.blogspot.com/-qaFgfVGy_0k/WgK53CMuQxI/AAAAAAAABZc/ppgRlQz9S-c7i4809pfpC9JqXOh9TilcACLcBGAs/s640/Tampilan%2BInterface%2BMs%2Bword%2B2010.jpg]


Penjelasan Dari Bagian - Bagian Tampilan (Interface) Ms.Word 2010 : 
· Quick Access Toolbar, kumpulan ikon atau tombol shortcut yang paling sering digunakan seperti New, Open, Save, Undo, Redo
· Title Bar : merupakan nama file dari dokumen yang terbuka
· Ribbon merupakan menu yang berisi kumpulan ikon perintah yang berhubungan dengan pengaturan file dokumen. Atau Ribbon adalah deretan tab berdasarkan kategori fitur - fitur tertentu yang sudah dikelompokan
· Tab adalah sederetan menu yang ditandai dengan teks. terdiri dari tab File, Insert, Page Layout, dll
· Grup Ribbon adalah kelompok menu dalam tiap Ribbon yang memiliki kesamaan fungsi
· Work Area atau Lembar kerja : merupakan tempat yang digunakan untuk mengetik teks pada microsoft word. Work area pada microsoft word sering disebut sebagai PAGE/WORKBOOK
· Zoom Level merupakan merupakan bagian yang berisi tombol-tombol perintah yang mengatur besar kecilnya tampilan lembar kerja
A. Menu File
File berisi ikon-ikon perintah yang berhubungan dengan pengaturan file dokumen

[image: https://2.bp.blogspot.com/-kczgRrIhUHo/WgLCAqRT3xI/AAAAAAAABZ8/0VI4geiEE6URLREGDxbSlvWhcTwth9fpwCLcBGAs/s320/menu%2Bfile.JPG]

Keterangan : 
• New : digunakan untuk membuat dokumen baru (CTRL + N)
• Open : digunakan untuk membuka dokumen (CTRL+O)
• Close : digunakan untuk menutup dokumen (ALT+F4)
• Save : digunakan untuk menyimpan dokumen (CTRL + S)
• Save As : digunakan untuk menyimpan dokumen dengan nama yang berbeda
• Print : digunakan untuk mencetak dokumen (CTRL+P)
• Undo : digunakan untuk membatalkan perintah terakhir (CTRL+Z)
• Redo : digunakan untuk mengembalikan perintah yang dibatalkan (CTRL+Y)


B. Tab Home
Tab Home merupakan tab yang paling sering digunakan berisikan fitur format teks seperti font dan perubahan paragraf
[image: https://1.bp.blogspot.com/-mI5v5VuQbRU/WgLDT5G9_ZI/AAAAAAAABaI/autMjktUpBEwfn426oY3Adl3U-cmDMVtQCLcBGAs/s1600/tab%2BHome.jpg]

Keterangan : 

Group Clipboard
· Cut : berfungsi untuk memotong teks/objek yang dipilih (CTRL + X)
· Copy : digunakan untuk menyalin teks atau objek yang dipilih (CTRL + C)
· Paste : berfungsi untuk menempelkan hasil copy atau paste (CTRL + V)
· Format painter : berfungsi untuk meniru format teks ke dokumen lainnya
Group Font
· Font : digunakan untuk memilih jenis huruf yang digunakan
· Font Size : digunakan untuk mengatur ukuran huruf
· Grow Font : Untuk memperbesar ukuran huruf secara instan
· Shrink Font : Untuk memperkecil ukuran huruf secara instan
· Bold : digunakan untuk menebalkan teks (CTRL+B)
· Italic :  digunakan untuk memiringkan teks (CTRL + I)
· Underline digunakan untuk memberikan garis bawah pada teks (CTRL + U)
· Change Case : digunakan untuk mengubah format penulisan huruf kapital.
Ada 5 jenis Change Case :
1) Sentence case : Teks huruf besar diawal karakter pada kata pertama
2) lowercase : Merubah semua huruf dalam kalimat menjadi huruf kecil
3) UPPERCASE : Merubah semua huruf dalam kalimat menjadi huruf kapital
4) Title Case : Huruf awal setiap kata dalam kalimat menjadi huruf besar(kapital)
5) tOGGLE cASE : Semua huruf awal pada setiap kata dalam kalimat menjadi huruf kecil
sedangkan huruf lainnya menjadi huruf kapital
· Clear Formatting : Untuk menghapus semua pemformatan teks terpilih
· Strikethrough : untuk memberikan tanda coret pada teks terpilih
· Subscript : digunakan untuk membuat teks pemangkatan yang berada dibawah
· Superscript : digunakan untuk membuat teks pemangkatan yang berada diatas
· Text Effect : untuk memberikan efek artistik pada teks terpilih
· Text Highlight Color : untuk memberikan warna stabilo di belakang teks terpilih
· Font Color : digunakan untuk memberi warna pada teks
Group Paragrap
· Bullets : digunakan untuk memberikan tanda bullets
· Numbering : digunakan untuk memberikan format penomoran secara otomatis pada suatu paragraf
· Decrease Indent : Untuk menggeser baris kedua paragraf ke kiri
· Increase Indent : untuk menggeser baris kedua paragraf ke kanan
· Sort : untuk mennyortir data
· Show Paragraph Marks : untuk menampilkan/menyembunyikan tanda koreksi paragraf
· Alignt Text Left : untuk mengatur teks/paragraf menjadi rata kiri
· Alignt  Text Right : untuk mengatur teks/paragraf menjadi rata kanan
· Center : untuk mengatur teks/paragraf menjadi rata tengah
· Justify : untuk mengatur teks/paragraf menjadi rata kanan dan kiri
· Line and Paragraph Spacing : untuk mengatur jarak antar baris teks. atau untuk mengatus spasi pada paragaf
· Border :  untuk memberikan garis tepi pada teks terpilih
· Shading : untuk mengatur warna latar teks terpilih
Group Styles
Group Styles terdiri dari dua menu, Yaitu :
· Heading Styles : digunakan untuk memberikan pilihan format penjudulan paragraf
· Change Styles  : berisi pilihan pengaturan tema paragraf
Group Editing
· Find :  untuk mencari kata tertentu dalam suatu dokumen
· Replace : untuk mencari dan mengganti kata yang ditemukan dalam suatu dokument

C. Tab Insert
Tab Insert, tab insert memungkinkan untuk memasukan berbagai item kedalam dokumen seperti gambar, clip art, tabel dan header dan footer
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Keterangan :
Group Table
· Table : Digunakan untuk menyisipkan tabel pada lembar kerja
Group Illustration
· Pictures : untuk menyisipkan objek gambar dari direktori yang tersimpan dalam komputer pada lembar kerja
· Clip Art :  untuk menyisipkan clip art atau gambar yang disediakan
· Shapes : digunakan menyisipkan objek shape atau berbagai jenis bentuk pada dokumen
· Chart : untuk menyisipkan objek grafik pada halaman
· SmartArt : untuk menyisipkan objek struktur organisasi, flow chart dan sebagainya pada halaman.
Group Header & Footer
· Header : untuk menambahkan teks/objek pada bagian header /bagian atas yang akan tampil pada setiap halaman .
· Footer : untuk menambahkan teks/objek pada bagian footer /bagian bawah yang akan tampil pada setiap halaman
· Page Number : untuk memberikan penomoran pada setiap halaman
Group Symbol
· Equation : untuk menyisipkan format matematika pada dokumen
· Symbol : untuk menyisipkan beberapa simbol pada dokumen

D. Tab Page Layout
Tab Page Layout pada tab ini memiliki perintah perintah unuk mengatur halaman seperti margin, orientasi, menyisipkan kolom, latar belakang dan tema.
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Keterangan :
Group Page Setup
· Margins untuk mengatur batas teks pada dokument
Untuk mengatur batas Atas kertas menggunakan menu Top
Untuk mengatur batas Bawah kertas menggunakan menu Bottom
Untuk mengatur batas Kiri kertas menggunakan menu Left
Untuk mengatur batas Kanan kertas menggunakan menu Right
· Orientation untuk mengatur posisi halaman
Pengaturan Landscape untuk mengatur posisi kertas secara horizontal/mendatar 
Pengaturan Portrait untuk mengatur posisi kertas secara vertikal/memanjang
· Size untuk mengatur ukuran kertas
Berikut ini merupakan ukuran kertas yang sering digunakan dalam keseharian : 
Ukuran kertas A4 : 210 mm x 297 mm
Ukuran kertas F4/Folio  : 216 mm x 330 mm
Ukuran Kertas Letter : 216 mm x 279 mm
Ukuran Kertas Quarto : 216 mm x 275 mm
Ukuran kertas Legal : 216 mm x 356 mm
· Colums untuk mengatur jumlah kolom teks pada halaman dokumen
Group Paragraph
· Spacing untuk mengatur jarak antara paragraph
· Indent untuk mengatur batas teks

E. Tab References
Tab ini memiliki perintah- perintah untuk digunakan saat membuat Daftar Isi dan halaman kutipan. Menu References berkaitan erat dengan Grup Table Of Content yang biasa digunakan untuk membuat daftar isi secara otomatis dalam microsoft word
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Keterangan :
Group Table of Content
· Table of Contents untuk mengelolah daftar isi
· Add Text untuk mengelolah paragraph yang terpilih menjadi masukan pada daftar isi yang dibuat.
· Update Table untuk memperbaharui daftar isi

F. Tab Mailings
Tab ini memungkinkan pengaturan dokumen untuk mengirim surat, seperti mencetak amplop, label atau pembuatan surat secara masal. Menu Mailing berkaitan erat dengan Mail Merge yang digunakan untuk membuat surat secara masal
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Keterangan :
Group Create 
· Envelopes untuk membuat amplop
· Labels untuk membuat label
Group Start Mail Merge
· Start Mail Merge untuk membuat surat (masal) yang biasa atau berupa email
· Select Recipients untuk membuat dan memilih penerima surat
· Edit Recepient List untuk mengubah daftar penerima surat



Lampiran 4. Instrumen Kuisioner Penelitian 

INDIKATOR KUISIONER TINGKAT KEMANDIRIAN SISWA
PADA PROSES PEMBELAJARAN SIMULASI DAN KOMUNIKASI DIGITAL
KELAS X  SMK NEGERI 1 GONDANG

	Variabel
	Indikator
	Butir
	Jumlah

	Kemandirian Belajar Peserta Didik
	Inisiatif belajar
	2, 5, 9, 10
	4

	
	Mendiagnosa kebutuhan belajar
	1, 6, 12, 18
	4

	
	Menetapkan target dan tujuan belajar
	7, 15, 20, 24
	4

	
	Memonitor dan mengontrol
	3, 8, 25
	3

	
	Menganggap kesulitan sebagai tantangan
	4, 13, 17
	3

	
	Memanfaatkan sumber belajar yang relevan
	14, 16, 26
	3

	
	Menentukan strategi belajar yang efektif
	21, 27, 28
	3

	
	Mengevaluasi proses dan hasil belajar
	19, 22, 30
	3

	
	Self efficacy (konsep diri)
	11, 23, 29
	3






 LEMBAR KUESIONER SISWA
PENGARUH  MODEL PEMBELAJARAN BLENDED LEARNING
DENGAN STRATEGI FLIPPED CLASSROOM 
TERHADAP KEMANDIRIAN DAN HASIL BELAJAR SISWA
PADA MATA PELAJARAN SIMULASI DIGITAL KELAS X
SMK NEGERI 1 GONDANG

A. Identitas Siswa 
Nama 		: 
No. Absen 	:
Kelas 		:
B. Petunjuk Pengisian 
1. Isilah daftar identitas yang telah disediakan.
2. Bacalah setiap pernyataan dengan teliti dan jangan sampai ada pertanyaan yang terlewatkan. 
3. Jawablah pernyataan dengan jujur, tanpa pengaruh oranglain karena jawaban anda tidak akan mempengaruhi nilai Simulasi Digital. 
4. Jawablah dengan memberi tanda cek () pada salah satu jawaban yang tersedia. 
C. Pertanyaan 
	NO
	PERNYATAAN
	Tidak Pernah
	Jarang
	Sering
	Selalu

	1
	Saya merasa semua mata pelajaran penting dan ada gunyanya.
	
	
	
	

	2
	Saya belajar atas kemauan saya sendiri
	
	
	
	

	3
	Saya datang tepat waktu ke sekolah
	
	
	
	

	4
	Saya merasa tertantang untuk dapat menyelesaikan soal-soal yang diberikan oleh guru
	
	
	
	

	5
	Saya bertanya kepada guru apabila merasa belum jelas terhadap materi pelajaran
	
	
	
	

	6
	Saya selalu mengetahui apa yang saya butuhkan dalam memahami suatu mata pelajaran
	
	
	
	

	7
	Saya meluangkan waktu saya untuk belajar
	
	
	
	

	8
	Saya masuk kelas sebelum pelajaran dimulai
	
	
	
	

	9
	Saya menanyakan sendiri kepada guru mengenai tugas yang belum diketahui
	
	
	
	

	10
	Saya bertanya mengenai pelajaran yang sulit kepada guru diluar jam pelajaran
	
	
	
	

	11
	Saya mempercayai kemampuan diri sendiri dalam mengerjakan tugas dibandingkan kemampuan teman-teman
	
	
	
	

	12
	Saya mempelajari materi secara mandiri sebelum diajarkan oleh guru 
	
	
	
	

	13
	Saya merasa saya mampu mengerjakan sendiri tugas tanpa bantuan teman-teman
	
	
	
	

	14
	Saya mencari sendiri jawaban atas soal-soal pelajaran yang diberikan guru
	
	
	
	

	15
	Saya langsung mengerjakan tugas apabila ada tugas dari guru
	
	
	
	

	16
	Saya mencari materi pelajaran di buku-buku pada perpustakaan sekolah
	
	
	
	

	17
	Saya selalu mengulangi hasil percobaan sampai berhasil jika hasil kurang memuaskan
	
	
	
	

	18
	Saya selalu mencatat materi yang sulit yang sudah diterangkan oleh guru
	
	
	
	

	19
	Saya selalu mengkoreksi ulang jawaban yang sudah saya kerjakan
	
	
	
	

	20
	Saya mengumpulkan tugas yang diberikan guru secara tepat waktu
	
	
	
	

	21
	Saya meluangkan waktu saya untuk belajar
	
	
	
	

	22
	Saya selalu mengulangi kembali pelajaran yang sudah diterangkan oleh guru di rumah
	
	
	
	

	23
	Saya merasa yakin bahwa saya dapat mengerjakan soal-soal tanpa meminta bantuan teman
	
	
	
	

	24
	Saya belajar meskipun tidak ada ujian
	
	
	
	

	25
	Saya mempersiapkan alat-alat yang perlu dibawa ke sekolah
	
	
	
	

	26
	Saya akan meminta bantuan teman untuk mendapatkan fotocopian materi bila diperlukan
	
	
	
	

	27
	Saya memperbayak latihan soal di rumah
	
	
	
	

	28
	Saya belajar sesuai jadwal yang saya tentukan
	
	
	
	

	29
	Saya dapat membantu teman ketika mereka mengalami kesulitan dalam belajar 
	
	
	
	

	30
	Saya berusaha mencari jawaban setelah mengerjakan ulangan
	
	
	
	





Lampiran 5. Kisi-kisi Instrument Tes Hasil Belajar
	[bookmark: _GoBack]No.
	Kompetensi Dasar
	Indikator Pencapaian Kompetensi
	Indikator Soal
	Bentuk Soal
	No Soal

	1
	Menentukan paragraf deskriptif, argumentatif, naratif, dan persuasif.

	Menganalisis ciri-ciri paragraf deskriptif, argumentatif, naratif, dan persuasif

	Menentukan jenis paragraf deskriptif, argumentatif, naratif, dan persuasif
	Pilihan Ganda
	1, 2

	
	
	Membandingkan paragraf deskriptif, argumentatif, naratif, dan persuasif.

	Menyebutkan ciri-ciri paragraf deskriptif, argumentatif, naratif, dan persuasif
	Pilihan Ganda
	3, 17

	2
	Memformat dokumen pengolah kata
	Memanipulasi dokumen menggunakan perangkat lunak pengolah kata.

	Menyimpan file/dokumen mengunakan berbagai format
	Pilihan Ganda
	4, 9, 10, 16

	
	
	Membuat tulisan deskriptif.

	Fitur-fitur untuk bagian berulang pada dokumen seperti: footer, header, pake numbering
	Pilihan Ganda
	5, 6, 14, 15

	
	
	Mengembangkan proposal menggunakan perangkat lunak pengolah kata.
	Fitur-fitur editing sederhana seperti: mengetik huruf/kata/kalimat, penjajaran teks (text alignment), penomoran, bullet, penggantian halaman, penggunakan kolom
	Pilihan Ganda
	7, 8, 11, 12, 13, 18, 19, 20




Lampiran 6. Instrument Tes Hasil Belajar Pretest

SOAL PRESTEST PILIHAN GANDA KOMUNIKASI DALAM JARINGAN 
MATA PELAJARAN SIMULASI DIGITAL 
SMK NEGERI 1 GONDANG
Nama		:						Hari/Tanggal	:
No Absen	:	
Kelas		:
Pilihlah jawaban dari pertanyaan dibawah ini dengan tepat !

1. 
2. Paragraf yang isinya berusaha untuk merebut perhatian pembaca adalah…
A. Paragraf Deskriptif
B. Paragraf Naratif
C. Paragraf Eksposisi
D. Paragraf Argumentatif
E. Paragraf Persuasif 
3. Sebuah paragraf yang gagasan utamanya dikembangkan dengan cara menjabarkan pendapat, ulasan, bahasan, atau ide pribadi penulisnya disebut….
A. Paragraf Deskriptif
B. Paragraf Naratif
C. Paragraf Argumentatif
D. Paragraf Persuasif
E. Paragraf Eksposisi
4. Menjabarkan suatu permasalahan dengan cara menganalisa dan menganalogikan adalah salah satu ciri-ciri paragraf…
A. Paragraf Deskriptif
B. Paragraf Persuasif
C. Pargraf Naratif
D. Paragraf Eksposisi
E. Paragraf Argumentatif
5. Perintah awal yang digunakan untuk mengaktifkan program MS Word adalah...
A. Start – Program – New
B. Start – Program – Micosoft Office Office
C. Start – Program – Open – Micosoft Office Word
D. Start – Program – MS DOS Prompt – File – Open
E. Start – Program – Micosoft Office – Micosoft Office Word
6. Pengaturan margin, ukuran kertas, orientasi beserta layout dokumen pada Microsoft Word 2010 dilakukan melalui menu…
A. Page Layout Paragraph
B. Page Layout – Page Setup
C. Page Layout – Page Background
D. Home – New – Blank Document
E. Insert – Header & Footer
7. Teks atau naskah yang terletak pada bagian atas halaman lembar kerja dan berulang di setiap halaman dokumen disebut…
A. Header
B. Footer
C. Footnote
D. Border
E. Column
8. Untuk membuat tulisan model koran kita menggunakan intruksi…
A. Insert > Columns
B. Insert > Clipart
C. Insert > Table
D. Page Layout > Columns
E. Page Lyout > Orientation
9. Untuk mengatur jarak spasi tulisan kita menggunakan intruksi
A. Home > Line Spacing
B. Home > Numbering
C. Home > Change Case
D. Insert > Line Spacing
E. Insert >  Drop cap
10. Agar kata “komputer” berubah menjadi “KOMPUTER” maka digunakan sub menu dari Change Case yaiyu…
A. Lower Case
B. Case Sentence
C. Toogle Case
D. Uppercase
E. Capitalize Each Word
11. Dalam suatu aplikasi komputer terdapat software microsoft office,salah satunya microsoft word berfungsi untuk membuat file documen, format penyimpanan data documen yang benar adalah…
A. .*docx
B. .*docs
C.  .*dos
D. .*dok
E. .*doq
12.  Perhatikan pernyataan berikut!
1. Klik table
2. Klik tab insert
3. Tentukan jumlah kolom dan baris
4. Klik insert table
5. Klik ok
Langkah-langkah yang benar untuk membuat sebuah tabel adalah….
A. (1), (2), (3), (4), (5)
B. (2), (1), (3), (4), (5)
C. (5), (4), (3), (2), (1)
D. (2), (1), (4), (3), (5)
E. (2), (1), (4), (5), (3)
13. Perintah memotong dan memindahkan text pada sebuah dokumen dilakukan dengan perintah….
A. CTRL+A dan CTRL+B
B.  CTRL+X dan CTRL+Z
C. CTRL+Y dan CTRL+Z
D. CTRL+V dan CTRL+X
E. CTRL+X dan CTRL+V
14. Apabila dalam sebuah dokumen terdapat lebih dari 100 halaman, kita dapat mencari dan mengganti dengan kata tertentu pada seluruh halaman dengan menggunakan fasilitas….
A.  Ascending and Descanding
B. Bullets and Numbering
C. Page Number
D. Drop Cap
E. Find and Replace
15. Dibawah ini menu-menu yang terdapat pada Microsoft Office Word, kecuali ….
A. Home
B. Data
C. Layout
D. Mailing
E. View 
16. Berikut ini manakah yang merupakan langkah-langkah menyisipkan gambar pada Microsoft Office Word….
A. Home -> insert -> picture -> pilih gambar
B. Insert -> picture -> pilih gambar
C. Home -> page layout -> picture
D. Home -> page borders -> picture
E. Insert -> picture -> pilih gambar -> insert
17. Ukuran kertas folio (F4) adalah ….
A.  21,5 x 29,7 cm
B. 21,5 x 27,9 cm
C. 21,5 x 35 cm
D. 21,5 x 33 cm
E. 21,5 x 29,7 cm
18. Berusaha menghindari konflik agar kepercayaan tidak hilang dan supaya kesepakatan pendapatnya tercapai….
A. Paragraf Persuasif
B. Paragraf Argumentatif
C. Paragraf Deskriptif
D. Paragraf Naratif
E. Paragraf Eksposisi
19. X2Y. angka 2 (pangkat) dapat dibuat dengan langkah…
A. Blok teksnya, pilih format, font, super script
B. Blok teksnya, pilih format, cell, font, superscript
C. Blok teksnya, pilih format, font, number, superscript
D. Blok teksnya, pilih format, autoformat, subscript
E. Blok teksnya, pilih format, cell, subcript
20. Untuk mengubah nomor tertentu pada bullets and numbering digunakan perintah….
A. Custumize
B. None
C. Bullets
D. Symbol
E. Numbering
21. Line between pada perintah column digunakan untuk membuat….
A. Garis miring
B. Garis rangkap
C. Garis pembatas
D. Tebal garis
E. Panjang Garis











KUNCI JAWABAN SOAL PRETEST 

1. 
2. E
3. C
4. E
5. E
6. A
7. A
8. D
9. A
10. D
11. A
12. D
13. E
14. E
15. B
16. E
17. B
18. A
19. A
20. C
21. B

Skor Total	= 100
Nilai 		= Benar X 5


Lampiran 7. Instrument Tes Hasil Belajar Posttest

SOAL PRESTEST PILIHAN GANDA KOMUNIKASI DALAM JARINGAN 
MATA PELAJARAN SIMULASI DIGITAL 
SMK NEGERI 1 GONDANG
Nama		:						Hari/Tanggal	:
No Absen	:	
Kelas		:
Pilihlah jawaban dari pertanyaan dibawah ini dengan tepat !

22. 
1. Sebuah paragraf yang menggambarkan atau melukiskan sebuah objek tertentu melalui kata-kata yang bisa merangsang panca indera adalah…
A. Paragraf Deskriptif
B. Paragraf Naratif
C. Paragraf Argumentatif
D. Paragraf Persuasif
E. Paragraf Eksposif
2. Paragraf yang isinya berusaha untuk merebut perhatian pembaca adalah…
A. Paragraf Deskriptif
B. Paragraf Naratif
C. Paragraf Eksposisi
D. Paragraf Argumentatif
E. Paragraf Persuasif 
3. Sebuah paragraf yang gagasan utamanya dikembangkan dengan cara menjabarkan pendapat, ulasan, bahasan, atau ide pribadi penulisnya disebut….
A. Paragraf Deskriptif
B. Paragraf Naratif
C. Paragraf Argumentatif
D. Paragraf Persuasif
E. Paragraf Eksposisi
4. Paragraf yang berisi tentang pemaparan suatu kejadian yang dirangkai dalam kesatuan waktu disebut…
A. Paragraf Deskriptif
B. Paragraf Argumentatif
C. Paragraf Naratif
D. Paragraf Persuasif
E. Paragraf Eksposisi
5. Menjabarkan suatu permasalahan dengan cara menganalisa dan menganalogikan adalah salah satu ciri-ciri paragraf…
A. Paragraf Deskriptif
B. Paragraf Persuasif
C. Pargraf Naratif
D. Paragraf Eksposisi
E. Paragraf Argumentatif
6. Perintah awal yang digunakan untuk mengaktifkan program MS Word adalah...
A. Start – Program – New
B. Start – Program – Micosoft Office Office
C. Start – Program – Open – Micosoft Office Word
D. Start – Program – MS DOS Prompt – File – Open
E. Start – Program – Micosoft Office – Micosoft Office Word
7. Pengaturan margin, ukuran kertas, orientasi beserta layout dokumen pada Microsoft Word 2010 dilakukan melalui menu…
A. Page Layout Paragraph
B. Page Layout – Page Setup
C. Page Layout – Page Background
D. Home – New – Blank Document
E. Insert – Header & Footer
8. Justity alignment dimaksudkan untuk membuat format dokumen yang rata…
A. Kanan
B. Kiri
C. Tengah
D. Kanan dan Kiri
E. Atas dan bawah
9. Teks atau naskah yang terletak pada bagian atas halaman lembar kerja dan berulang di setiap halaman dokumen disebut…
A. Header
B. Footer
C. Footnote
D. Border
E. Column
10. Untuk membuat tulisan model koran kita menggunakan intruksi…
A. Insert > Columns
B. Insert > Clipart
C. Insert > Table
D. Page Layout > Columns
E. Page Lyout > Orientation
11. Untuk mengatur jarak spasi tulisan kita menggunakan intruksi
A. Home > Line Spacing
B. Home > Numbering
C. Home > Change Case
D. Insert > Line Spacing
E. Insert >  Drop cap
12. Agar kata “komputer” berubah menjadi “KOMPUTER” maka digunakan sub menu dari Change Case yaiyu…
A. Lower Case
B. Case Sentence
C. Toogle Case
D. Uppercase
E. Capitalize Each Word
13. Dalam suatu aplikasi komputer terdapat software microsoft office,salah satunya microsoft word berfungsi untuk membuat file documen, format penyimpanan data documen yang benar adalah…
A. .*docx
B. .*docs
C.  .*dos
D. .*dok
E. .*doq
14.  Perhatikan pernyataan berikut!
1. Klik table
2. Klik tab insert
3. Tentukan jumlah kolom dan baris
4. Klik insert table
5. Klik ok
Langkah-langkah yang benar untuk membuat sebuah tabel adalah….
A. (1), (2), (3), (4), (5)
B. (2), (1), (3), (4), (5)
C. (5), (4), (3), (2), (1)
D. (2), (1), (4), (3), (5)
E. (2), (1), (4), (5), (3)
15. Perintah memotong dan memindahkan text pada sebuah dokumen dilakukan dengan perintah….
A. CTRL+A dan CTRL+B
B.  CTRL+X dan CTRL+Z
C. CTRL+Y dan CTRL+Z
D. CTRL+V dan CTRL+X
E. CTRL+X dan CTRL+V
16. Apabila dalam sebuah dokumen terdapat lebih dari 100 halaman, kita dapat mencari dan mengganti dengan kata tertentu pada seluruh halaman dengan menggunakan fasilitas….
A.  Ascending and Descanding
B. Bullets and Numbering
C. Page Number
D. Drop Cap
E. Find and Replace
17. Dibawah ini menu-menu yang terdapat pada Microsoft Office Word, kecuali ….
A. Home
B. Data
C. Layout
D. Mailing
E. View 
18. Berikut ini manakah yang merupakan langkah-langkah menyisipkan gambar pada Microsoft Office Word….
A. Home -> insert -> picture -> pilih gambar
B. Insert -> picture -> pilih gambar
C. Home -> page layout -> picture
D. Home -> page borders -> picture
E. Insert -> picture -> pilih gambar -> insert
19. Ukuran kertas folio (F4) adalah ….
A.  21,5 x 29,7 cm
B. 21,5 x 27,9 cm
C. 21,5 x 35 cm
D. 21,5 x 33 cm
E. 21,5 x 29,7 cm
20. Perintah shortcut keyboard untuk membuat jarak tulisan menjadi satu setengah spasi pada ms. Word, setelah semua area terseleksi adalah….
A. Ctrl + P
B. Ctrl + 1
C. Ctrl + 5
D. Ctrl + 1,5
E. Ctrl + 2
21. Perintah shortcurt keyboard untuk menyeleksi semua area tulisan pada aplikasi Microsoft Office Word adalah….
A. Ctrl + V
B. Ctrl + C
C. Ctrl + A
D. Ctrl + B
E. Ctrl + P
22. X2Y. angka 2 (pangkat) dapat dibuat dengan langkah…
A. Blok teksnya, pilih format, font, super script
B. Blok teksnya, pilih format, cell, font, superscript
C. Blok teksnya, pilih format, font, number, superscript
D. Blok teksnya, pilih format, autoformat, subscript
E. Blok teksnya, pilih format, cell, subcript
23. Untuk mengubah nomor tertentu pada bullets and numbering digunakan perintah….
A. Custumize
B. None
C. Bullets
D. Symbol
E. Numbering
24. Line between pada perintah column digunakan untuk membuat….
A. Garis miring
B. Garis rangkap
C. Garis pembatas
D. Tebal garis
E. Panjang Garis
25. Width di gunakan untuk…
A. Pengaturan ukuran tinggi kertas
B. Pengaturan ukuran lebar kertas
C. Pengaturan ukuran kertas yang digunakan
D. Pengaturan ukuran dokumen
E. Pengaturan ukuran pinggir kertas











KUNCI JAWABAN SOAL PRETEST 

	1.
	A
	6.
	E
	11.
	A
	16.
	E
	21.
	C

	2.
	E
	7.
	A
	12.
	D
	17.
	B
	22.
	A

	3.
	C
	8.
	D
	13.
	A
	18.
	E
	23..
	C

	4.
	C
	9.
	A
	14.
	D
	19.
	B
	24.
	B

	5.
	E
	10.
	D
	15.
	E
	20.
	D
	25.
	B



Skor Total	= 100
Nilai 		= Benar x 4


Lampiran 9. Hasil Uji Validitas Instrumen Kuisioner
RANGKUMAN PENGUJIAN VALIDITAS INSTRUMEN KUISIONER 
	No. Item
	rhitung
	rtabel 5% N(30)
	Keterangan

	1
	.441*
	.361
	VALID

	2
	-,324
	.361
	TIDAK VALID

	3
	.531**
	.361
	VALID

	4
	.463**
	.361
	VALID

	5
	.492**
	.361
	VALID

	6
	,323
	.361
	TIDAK VALID

	7
	.538**
	.361
	VALID

	8
	.451*
	.361
	VALID

	9
	.555**
	.361
	VALID

	10
	.507**
	.361
	VALID

	11
	.466**
	.361
	VALID

	12
	,045
	.361
	TIDAK VALID

	13
	.602**
	.361
	VALID

	14
	.495**
	.361
	VALID

	15
	.445*
	.361
	VALID

	16
	.718**
	.361
	VALID

	17
	.585**
	.361
	VALID

	18
	.626**
	.361
	VALID

	19
	.362*
	.361
	VALID

	20
	.466**
	.361
	VALID

	21
	.484**
	.361
	VALID

	22
	.448*
	.361
	VALID

	23
	.485**
	.361
	VALID

	24
	.446*
	.361
	VALID

	25
	-,063
	.361
	TIDAK VALID

	26
	.616**
	.361
	VALID

	27
	,354
	.361
	TIDAK VALID

	28
	.722**
	.361
	VALID

	29
	.729**
	.361
	VALID

	30
	,244
	.361
	TIDAK VALID

	JUMLAH ITEM VALID
	24 ITEM





Lampiran 10. Uji Reliabilitas Instrumen Kuisioner
HASIL PENGUJIAN SPSS RELIABILITAS KUISIONER 
	Reliability Statistics

	Cronbach's Alpha
	N of Items

	,893
	24





Lampiran 11. Uji Validitas Instrumen Pretest
	Correlations

	 
	butir_1
	butir_2
	butir_3
	butir_4
	butir_5
	butir_6
	butir_7

	jawabanbenar
	Pearson Correlation
	.416*
	.413*
	.555**
	.389*
	.399*
	.387*
	.559**

	
	Sig. (2-tailed)
	,022
	,023
	,001
	,034
	,029
	,035
	,001

	
	N
	30
	30
	30
	30
	30
	30
	30

	 
	butir_8
	butir_9
	butir_10
	butir_11
	butir_12
	butir_13
	butir_14

	jawabanbenar
	Pearson Correlation
	.488**
	.411*
	,309
	.555**
	.489**
	,056
	,134

	
	Sig. (2-tailed)
	,006
	,024
	,097
	,001
	,006
	,768
	,480

	
	N
	30
	30
	30
	30
	30
	30
	30

	 
	butir_15
	butir_16
	butir_17
	butir_18
	butir_19
	butir_20
	butir_21

	jawabanbenar
	Pearson Correlation
	0,000
	.448*
	.368*
	0,000
	.416*
	.633**
	.371*

	
	Sig. (2-tailed)
	1,000
	,013
	,046
	1,000
	,022
	,000
	,043

	
	N
	30
	30
	30
	30
	30
	30
	30

	 
	butir_22
	butir_23
	butir_24
	butir_25
	butir_26
	butir_27
	butir_28

	jawabanbenar
	Pearson Correlation
	,348
	.396*
	,140
	.687**
	,015
	-,163
	.428*

	
	Sig. (2-tailed)
	,060
	,030
	,459
	,000
	,936
	,389
	,018

	
	N
	30
	30
	30
	30
	30
	30
	30

	 
	butir_29
	butir_30
	jawabanbenar
	
	
	
	

	jawabanbenar
	Pearson Correlation
	.618**
	-,290
	1
	
	
	
	

	
	Sig. (2-tailed)
	,000
	,120
	 
	
	
	
	

	
	N
	30
	30
	30
	
	
	
	





RANGKUMAN PENGUJIAN VALIDITAS INSTRUMEN PRETEST
	No. Item
	rhitung 
	rtabel 5% N(30)
	Keterangan

	1
	.416*
	.361
	VALID

	2
	.413*
	.361
	VALID

	3
	.555**
	.361
	VALID

	4
	.389*
	.361
	VALID

	5
	.399*
	.361
	VALID

	6
	.387*
	.361
	VALID

	7
	.559**
	.361
	VALID

	8
	.488**
	.361
	VALID

	9
	.411*
	.361
	VALID

	10
	,309
	.361
	TIDAK VALID

	11
	.555**
	.361
	VALID

	12
	.489**
	.361
	VALID

	13
	,056
	.361
	TIDAK VALID

	14
	,134
	.361
	TIDAK VALID

	15
	0,000
	.361
	TIDAK VALID

	16
	.448*
	.361
	VALID

	17
	.368*
	.361
	VALID

	18
	0,000
	.361
	TIDAK VALID

	19
	.416*
	.361
	VALID

	20
	.633**
	.361
	VALID

	21
	.371*
	.361
	VALID

	22
	,348
	.361
	TIDAK VALID

	23
	.396*
	.361
	VALID

	24
	,140
	.361
	TIDAK VALID

	25
	.687**
	.361
	VALID

	26
	,015
	.361
	TIDAK VALID

	27
	-,163
	.361
	TIDAK VALID

	28
	.428*
	.361
	VALID

	29
	.618**
	.361
	VALID

	30
	-,290
	.361
	TIDAK VALID

	JUMLAH ITEM VALID
	20 ITEM





Lampiran 12. Uji Reliabilitas Instrument Pretest
HASIL PENGUJIAN SPSS RELIABILITAS PRETEST  

	Reliability Statistics

	Cronbach's Alpha
	N of Items

	.717
	30





Lampiran 14. Uji tingkat kesukaran instrument pretest
HASIL PENGUJIAN SPSS TINGKAT KESUKARAN INSTRUMEN SOAL PRETEST
	Statistics

	 
	butir_1
	butir_2
	butir_3
	butir_4
	butir_5
	butir_6
	butir_7

	N
	Valid
	30
	30
	30
	30
	30
	30
	30

	
	Missing
	0
	0
	0
	0
	0
	0
	0

	Mean
	,57
	,77
	,67
	,67
	,70
	,57
	,63

	 
	butir_8
	butir_9
	butir_10
	butir_11
	butir_12
	butir_13
	butir_14

	N
	Valid
	30
	30
	30
	30
	30
	30
	30

	
	Missing
	0
	0
	0
	0
	0
	0
	0

	Mean
	,57
	,63
	,40
	,70
	,80
	,53
	,40

	 
	butir_15
	butir_16
	butir_17
	butir_18
	butir_19
	butir_20
	butir_21

	N
	Valid
	30
	30
	30
	30
	30
	30
	30

	
	Missing
	0
	0
	0
	0
	0
	0
	0

	Mean
	,50
	,37
	,70
	,50
	,57
	,63
	,53

	 
	butir_22
	butir_23
	butir_24
	butir_25
	butir_26
	butir_27
	butir_28

	N
	Valid
	30
	30
	30
	30
	30
	30
	30

	
	Missing
	0
	0
	0
	0
	0
	0
	0

	Mean
	,73
	,63
	,83
	,73
	,47
	,60
	,73

	 
	butir_29
	butir_30
	
	
	
	
	

	N
	Valid
	30
	30
	
	
	
	
	

	
	Missing
	0
	0
	
	
	
	
	

	Mean
	,63
	,30
	
	
	
	
	





RANGKUMAN HASIL PENGUJIAN TINGKAT KESUKARAN INSTRUMEN SOAL PRETEST 
	No. Item
	Indeks Kesukaran
	Kesimpulan

	1
	,57
	Sedang

	2
	,77
	Mudah

	3
	,67
	Sedang

	4
	,67
	Sedang

	5
	,70
	Mudah

	6
	,57
	Sedang

	7
	,63
	Sedang

	8
	,57
	Sedang

	9
	,63
	Sedang

	10
	,40
	Sedang

	11
	,70
	Mudah

	12
	,80
	Mudah

	13
	,53
	Sedang

	14
	,40
	Sedang

	15
	,50
	Sedang

	16
	,37
	Sedang

	17
	,70
	Mudah

	18
	,50
	Sedang

	19
	,57
	Sedang

	20
	,63
	Sedang

	21
	,53
	Sedang

	22
	,73
	Mudah

	23
	,63
	Sedang

	24
	,83
	Mudah

	25
	,73
	Mudah

	26
	,47
	Sedang

	27
	,60
	Sedang

	28
	,73
	Mudah

	29
	,63
	Sedang

	30
	,30
	Sedang




Lampiran 13. Uji Daya Pembeda Instrumen Pretest
HASIL PERHITUNGAN DAYA PEMBEDA INSTRUMEN SOAL PRETEST
	No. Item
	Indeks Daya Pembeda
	Kesimpulan

	1
	0,33
	Cukup

	2
	0,33
	Cukup

	3
	0,67
	Baik

	4
	0,27
	Cukup

	5
	0,20
	Cukup

	6
	0,20
	Cukup

	7
	0,33
	Cukup

	8
	0,33
	Cukup

	9
	0,47
	Baik

	10
	0,13
	Buruk

	11
	0,60
	Baik

	12
	0,27
	Cukup

	13
	0,00
	Buruk

	14
	0,27
	Cukup

	15
	-0,07
	Buruk

	16
	0,33
	Cukup

	17
	0,33
	Cukup

	18
	-0,07
	Buruk

	19
	0,47
	Baik

	20
	0,47
	Baik

	21
	0,40
	Baik

	22
	0,27
	Cukup

	23
	0,33
	Cukup

	24
	0,07
	Buruk

	25
	0,53
	Baik

	26
	0,00
	Buruk

	27
	-0,27
	Buruk

	28
	0,53
	Baik

	29
	0,73
	Baik Sekali

	30
	-0,33
	Buruk





Lampiran 15. Uji Validitas Instrumen Posttest
HASIL VALIDITAS SPSS INSTRUMEN POSTTEST
	Correlations

	 
	butir_1
	butir_2
	butir_3
	butir_4
	butir_5
	butir_6
	butir_7

	jawabanbenar
	Pearson Correlation
	,046
	-,211
	.645**
	.402*
	.606**
	.372*
	.552**

	
	Sig. (2-tailed)
	,809
	,264
	,000
	,027
	,000
	,043
	,002

	
	N
	30
	30
	30
	30
	30
	30
	30

	 
	butir_8
	butir_9
	butir_10
	butir_11
	butir_12
	butir_13
	butir_14

	jawabanbenar
	Pearson Correlation
	.508**
	.566**
	.666**
	,319
	.471**
	.503**
	.529**

	
	Sig. (2-tailed)
	,004
	,001
	,000
	,086
	,009
	,005
	,003

	
	N
	30
	30
	30
	30
	30
	30
	30

	 
	butir_15
	butir_16
	butir_17
	butir_18
	butir_19
	butir_20
	butir_21

	jawabanbenar
	Pearson Correlation
	.382*
	.468**
	.425*
	,266
	,284
	.648**
	.368*

	
	Sig. (2-tailed)
	,037
	,009
	,019
	,156
	,128
	,000
	,046

	
	N
	30
	30
	30
	30
	30
	30
	30

	 
	butir_22
	butir_23
	butir_24
	butir_25
	butir_26
	butir_27
	butir_28

	jawabanbenar
	Pearson Correlation
	.382*
	.457*
	,218
	.519**
	-,110
	-.411*
	,043

	
	Sig. (2-tailed)
	,037
	,011
	,246
	,003
	,564
	,024
	,820

	
	N
	30
	30
	30
	30
	30
	30
	30

	 
	butir_29
	butir_30
	jawabanbenar
	
	
	
	

	jawabanbenar
	Pearson Correlation
	.479**
	.430*
	1
	
	
	
	

	 
	Sig. (2-tailed)
	,007
	,018
	 
	
	
	
	

	 
	N
	30
	30
	30
	
	
	
	





RANGKUMAN PENGUJIAN VALIDITAS INSTRUMEN POSTTEST
	No. Item
	rhitung 
	rtabel 5% N(30)
	Keterangan

	1
	,046
	.361
	TIDAK VALID

	2
	-,211
	.361
	TIDAK VALID

	3
	.645**
	.361
	VALID

	4
	.402*
	.361
	VALID

	5
	.606**
	.361
	VALID

	6
	.372*
	.361
	VALID

	7
	.552**
	.361
	VALID

	8
	.508**
	.361
	VALID

	9
	.566**
	.361
	VALID

	10
	.666**
	.361
	VALID

	11
	,319
	.361
	TIDAK VALID

	12
	.471**
	.361
	VALID

	13
	.503**
	.361
	VALID

	14
	.529**
	.361
	VALID

	15
	.382*
	.361
	VALID

	16
	.468**
	.361
	VALID

	17
	.425*
	.361
	VALID

	18
	,266
	.361
	TIDAK VALID

	19
	,284
	.361
	TIDAK VALID

	20
	.648**
	.361
	VALID

	21
	.368*
	.361
	VALID

	22
	.382*
	.361
	VALID

	23
	.457*
	.361
	VALID

	24
	,218
	.361
	TIDAK VALID

	25
	.519**
	.361
	VALID

	26
	-,110
	.361
	TIDAK VALID

	27
	-.411*
	.361
	VALID

	28
	,043
	.361
	TIDAK VALID

	29
	.479**
	.361
	VALID

	30
	.430*
	.361
	VALID

	JUMLAH ITEM VALID
	22 ITEM





Lampiran 16. Uji Reliabilitas Instrumen Posttest
HASIL RELIABILITAS SPSS INSTRUMEN POSTTEST



Lampiran 18. Uji Tingkat Kesukaran Instrumen Posttest
HASIL PENGUJIAN SPSS TINGKAT KESUKARAN INSTRUMEN POSTEST
	Statistics

	 
	butir_1
	butir_2
	butir_3
	butir_4
	butir_5
	butir_6
	butir_7

	N
	Valid
	30
	30
	30
	30
	30
	30
	30

	
	Missing
	0
	0
	0
	0
	0
	0
	0

	Mean
	,70
	,90
	,53
	,63
	,50
	,77
	,73

	 
	butir_8
	butir_9
	butir_10
	butir_11
	butir_12
	butir_13
	butir_14

	N
	Valid
	30
	30
	30
	30
	30
	30
	30

	
	Missing
	0
	0
	0
	0
	0
	0
	0

	Mean
	,43
	,50
	,33
	,70
	,83
	,47
	,30

	 
	butir_15
	butir_16
	butir_17
	butir_18
	butir_19
	butir_20
	butir_21

	N
	Valid
	30
	30
	30
	30
	30
	30
	30

	
	Missing
	0
	0
	0
	0
	0
	0
	0

	Mean
	,50
	,23
	,80
	,47
	,67
	,63
	,53

	 
	butir_22
	butir_23
	butir_24
	butir_25
	butir_26
	butir_27
	butir_28

	N
	Valid
	30
	30
	30
	30
	30
	30
	30

	
	Missing
	0
	0
	0
	0
	0
	0
	0

	Mean
	,67
	,63
	,70
	,60
	,57
	,53
	,43

	 
	butir_29
	butir_30
	
	
	
	
	

	N
	Valid
	30
	30
	
	
	
	
	

	
	Missing
	0
	0
	
	
	
	
	

	Mean
	,67
	,17
	
	
	
	
	




RANGKUMAN HASIL PENGUJIAN TINGKAT KESUKARAN INSTRUMEN SOAL PRETEST 
	No. Item
	Indeks Kesukaran
	Kesimpulan

	1
	,70
	Sedang

	2
	,90
	Mudah

	3
	,53
	Sedang

	4
	,63
	Mudah

	5
	,50
	Mudah

	6
	,77
	Mudah

	7
	,73
	Mudah

	8
	,43
	Sedang

	9
	,50
	Sedang

	10
	,33
	Sedang

	11
	,70
	Sedang

	12
	,83
	Mudah

	13
	,47
	Sedang

	14
	,30
	Sukar

	15
	,50
	Sedang

	16
	,23
	Sukar

	17
	,80
	Mudah

	18
	,47
	Sedang

	19
	,67
	Sedang

	20
	,63
	Sedang

	21
	,53
	Sedang

	22
	,67
	Sedang

	23
	,63
	Sedang

	24
	,70
	Sedang

	25
	,60
	Sedang

	26
	,57
	Sedang

	27
	,53
	Sedang

	28
	,43
	Sedang

	29
	,67
	Sedang

	30
	,17
	Sukar





Lampiran 17. Uji Daya Pembeda Instrumen Posttest
HASIL PERHITUNGAN DAYA PEMBEDA INTRUMEN POSTTEST 
	No. Item
	Indeks Daya Pembeda
	Kesimpulan

	1
	-0,20
	Buruk

	2
	-0,20
	Buruk

	3
	0,67
	Baik

	4
	0,33
	Cukup

	5
	0,60
	Baik

	6
	0,33
	Cukup

	7
	0,40
	Cukup

	8
	0,47
	Baik

	9
	0,60
	Baik

	10
	0,53
	Baik

	11
	0,20
	Cukup

	12
	0,33
	Cukup

	13
	0,53
	Baik

	14
	0,33
	Cukup

	15
	0,47
	Baik

	16
	0,20
	Cukup

	17
	0,13
	Buruk

	18
	0,13
	Buruk

	19
	0,13
	Buruk

	20
	0,73
	Baik Sekali

	21
	0,27
	Cukup

	22
	0,27
	Cukup

	23
	0,47
	Baik

	24
	0,07
	Buruk

	25
	0,53
	Baik

	26
	-0,07
	Buruk

	27
	-0,27
	Buruk

	28
	-0,20
	Buruk

	29
	0,53
	Baik

	30
	0,07
	Buruk





Lampiran 19. Uji Normalitas
PENGUJIAN NORMALITAS SPSS KUESIONER
	Tests of Normality

	kelas
	Kolmogorov-Smirnova
	Shapiro-Wilk

	
	Statistic
	df
	Sig.
	Statistic
	df
	Sig.

	Skor Kemandirian Pretest
	Kelas Eksperimen
	,142
	35
	,073
	,948
	35
	,100

	
	Kelas Kontrol
	,144
	35
	,064
	,959
	35
	,212



	Tests of Normality

	kelas
	Kolmogorov-Smirnova
	Shapiro-Wilk

	
	Statistic
	df
	Sig.
	Statistic
	df
	Sig.

	Skor Kemandirian Posttest
	Kelas Eksperimen
	,128
	35
	,162
	,935
	35
	,041

	
	Kelas Kontrol
	,141
	35
	,077
	,972
	35
	,507



PENGUJIAN NORMALITAS SPSS HASIL BELAJAR
	Tests of Normality

	Kelas
	Kolmogorov-Smirnova
	Shapiro-Wilk

	
	Statistic
	df
	Sig.
	Statistic
	df
	Sig.

	Hasil Belajar Siswa Pretest
	Kelas Eksperimen
	,145
	35
	,059
	,944
	35
	,072

	
	Kelas Kontrol
	,134
	35
	,113
	,954
	35
	,155



	Tests of Normality

	Kelas
	Kolmogorov-Smirnova
	Shapiro-Wilk

	
	Statistic
	df
	Sig.
	Statistic
	df
	Sig.

	Hasil Belajar Siswa
	Kelas Eksperimen
	,146
	35
	,056
	,945
	35
	,080

	
	Kelas Kontrol
	,146
	35
	,057
	,929
	35
	,026


Lampiran 20. Uji Homogenitas
PENGUJIAN HOMOGENITAS KEMANDIRIAN

	Test of Homogeneity of Variance

	 
	Levene Statistic
	df1
	df2
	Sig.

	Skor Kemandirian Pretest
	2,512
	1
	68
	,118



	Test of Homogeneity of Variance

	 
	Levene Statistic
	df1
	df2
	Sig.

	Skor Kemandirian Posttest
	,145
	1
	68
	,704



PENGUJIAN HOMOGENITAS HASIL BELAJAR

	Test of Homogeneity of Variance

	Hasil Belajar Siswa Pretest

	Levene Statistic
	df1
	df2
	Sig.

	,046
	1
	68
	,831



	Test of Homogeneity of Variance

	Hasil Belajar Siswa Posttest

	Levene Statistic
	df1
	df2
	Sig.

	1,932
	1
	68
	,169





Lampiran 21. Uji Keseimbangan 
PENGUJIAN KESEIMBANGAN KEMANDIRIAN
	Independent Samples Test

	 
	Levene's Test for Equality of Variances
	t-test for Equality of Means

	
	F
	Sig.
	t
	df
	Sig. (2-tailed)
	Mean Difference
	Std. Error Difference
	95% Confidence Interval of the Difference

	
	
	
	
	
	
	
	
	Lower
	Upper

	Skor Kemandirian Pretest
	Equal variances assumed
	2,512
	,118
	1,045
	68
	,300
	1,286
	1,231
	-1,170
	3,741

	
	Equal variances not assumed
	 
	 
	1,045
	65,598
	,300
	1,286
	1,231
	-1,172
	3,743



	Independent Samples Test

	 
	Levene's Test for Equality of Variances
	t-test for Equality of Means

	
	F
	Sig.
	t
	df
	Sig. (2-tailed)
	Mean Difference
	Std. Error Difference
	95% Confidence Interval of the Difference

	
	
	
	
	
	
	
	
	Lower
	Upper

	Skor Kemandirian Posttest
	Equal variances assumed
	,145
	,704
	3,572
	68
	,001
	3,886
	1,088
	1,715
	6,056

	
	Equal variances not assumed
	 
	 
	3,572
	67,843
	,001
	3,886
	1,088
	1,715
	6,056





PENGUJIAN KESEIMBANGAN HASIL BELAJAR
	Independent Samples Test

	 
	Levene's Test for Equality of Variances
	t-test for Equality of Means

	
	F
	Sig.
	t
	df
	Sig. (2-tailed)
	Mean Difference
	Std. Error Difference
	95% Confidence Interval of the Difference

	
	
	
	
	
	
	
	
	Lower
	Upper

	Hasil Belajar Siswa
	Equal variances assumed
	,046
	,831
	-,246
	68
	,806
	-,486
	1,973
	-4,424
	3,452

	
	Equal variances not assumed
	 
	 
	-,246
	67,672
	,806
	-,486
	1,973
	-4,424
	3,452



	Independent Samples Test

	 
	Levene's Test for Equality of Variances
	t-test for Equality of Means

	
	F
	Sig.
	t
	df
	Sig. (2-tailed)
	Mean Difference
	Std. Error Difference
	95% Confidence Interval of the Difference

	
	
	
	
	
	
	
	
	Lower
	Upper

	Hasil Belajar Siswa
	Equal variances assumed
	1,932
	,169
	8,580
	68
	,000
	12,571
	1,465
	9,648
	15,495

	
	Equal variances not assumed
	 
	 
	8,580
	63,863
	,000
	12,571
	1,465
	9,644
	15,499





Lampiran 22. Uji Gain Ternormalisasi  
HASIL UJI GAIN HASIL BELAJAR PADA SPSS 
	Descriptives

	Kelas
	Statistic
	Std. Error

	ngain
	Kelas Eksperimen
	Mean
	,4512
	,03630

	
	
	95% Confidence Interval for Mean
	Lower Bound
	,3774
	 

	
	
	
	Upper Bound
	,5249
	 

	
	
	5% Trimmed Mean
	,4695
	 

	
	
	Median
	,4651
	 

	
	
	Variance
	,046
	 

	
	
	Std. Deviation
	,21474
	 

	
	
	Minimum
	-,30
	 

	
	
	Maximum
	,75
	 

	
	
	Range
	1,05
	 

	
	
	Interquartile Range
	,28
	 

	
	
	Skewness
	-1,459
	,398

	
	
	Kurtosis
	3,428
	,778

	
	Kelas Kontrol
	Mean
	,1591
	,03989

	
	
	95% Confidence Interval for Mean
	Lower Bound
	,0780
	 

	
	
	
	Upper Bound
	,2402
	 

	
	
	5% Trimmed Mean
	,1639
	 

	
	
	Median
	,1400
	 

	
	
	Variance
	,056
	 

	
	
	Std. Deviation
	,23596
	 

	
	
	Minimum
	-,59
	 

	
	
	Maximum
	,64
	 

	
	
	Range
	1,23
	 

	
	
	Interquartile Range
	,30
	 

	
	
	Skewness
	-,492
	,398

	
	
	Kurtosis
	2,060
	,778





Lampiran 24. Nilai Hasil Kemandirian
	No
	AWAL
	AKHIR

	
	Kelas Eksperimen
	Kelas Kontrol
	Kelas Eksperimen
	Kelas Kontrol

	
	
	
	
	

	1
	69
	74
	78
	79

	2
	80
	66
	81
	80

	3
	73
	72
	74
	73

	4
	83
	76
	86
	73

	5
	72
	75
	70
	73

	6
	80
	80
	76
	75

	7
	70
	65
	69
	78

	8
	77
	78
	77
	84

	9
	68
	66
	80
	71

	10
	76
	62
	78
	72

	11
	71
	63
	77
	70

	12
	76
	69
	83
	71

	13
	67
	77
	82
	80

	14
	79
	78
	74
	70

	15
	73
	82
	77
	64

	16
	76
	75
	80
	75

	17
	80
	74
	75
	73

	18
	76
	74
	81
	73

	19
	69
	75
	78
	74

	20
	71
	80
	79
	82

	21
	68
	69
	94
	72

	22
	77
	67
	83
	79

	23
	69
	70
	76
	70

	24
	72
	65
	82
	81

	25
	72
	74
	77
	72

	26
	69
	71
	77
	67

	27
	67
	66
	87
	80

	28
	76
	67
	77
	76

	29
	65
	78
	75
	78

	30
	66
	67
	78
	74

	31
	71
	62
	79
	72

	32
	72
	71
	76
	79

	33
	71
	64
	75
	76

	34
	68
	67
	80
	78

	35
	68
	73
	82
	73

	Juml
	2537
	2492
	2753
	2617

	Rata2
	72,48571429
	71,2
	78,65714286
	74,77142857


Lampiran 24. Nilai Hasil Belajar
	No
	Nilai Pretest 
	
	No
	Nilai Postest

	
	Kelas Eksperimen
	Kelas Kontrol
	
	
	Kelas Eksperimen
	Kelas Kontrol

	
	
	
	
	
	
	

	1
	47
	60
	
	1
	80
	63

	2
	60
	63
	
	2
	67
	60

	3
	53
	47
	
	3
	80
	63

	4
	53
	57
	
	4
	73
	60

	5
	57
	47
	
	5
	77
	67

	6
	53
	67
	
	6
	73
	63

	7
	50
	60
	
	7
	70
	60

	8
	50
	47
	
	8
	80
	67

	9
	63
	50
	
	9
	77
	60

	10
	60
	58
	
	10
	73
	63

	11
	47
	50
	
	11
	77
	60

	12
	60
	43
	
	12
	80
	60

	13
	70
	60
	
	13
	77
	64

	14
	57
	60
	
	14
	83
	60

	15
	53
	43
	
	15
	73
	57

	16
	67
	47
	
	16
	77
	77

	17
	77
	60
	
	17
	70
	63

	18
	60
	67
	
	18
	70
	77

	19
	50
	70
	
	19
	80
	73

	20
	60
	60
	
	20
	73
	60

	21
	67
	67
	
	21
	67
	63

	22
	47
	50
	
	22
	83
	80

	23
	47
	60
	
	23
	73
	57

	24
	73
	53
	
	24
	80
	83

	25
	53
	47
	
	25
	77
	57

	26
	50
	73
	
	26
	73
	57

	27
	67
	53
	
	27
	80
	63

	28
	57
	50
	
	28
	83
	67

	29
	60
	57
	
	29
	90
	73

	30
	45
	53
	
	30
	77
	70

	31
	45
	67
	
	31
	80
	70

	32
	50
	60
	
	32
	87
	63

	33
	47
	63
	
	33
	80
	60

	34
	43
	53
	
	34
	83
	63

	35
	57
	50
	
	35
	77
	57

	Juml
	1955
	1972
	
	Juml
	2700
	2260

	Rata2
	55,86
	56,34
	
	Rata2
	77,14
	64,57
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VIRUS ROMPUIER
Dalam kehidupan ini terdapat beribu ¥isus yang dapat menjangkit manusia. Sampai saat
skarang ini kita mash disibukkan dengan virus yamg bemama HIV yang bias
mengakibatian kekebalan tubuh manusia.
Seperti halnya manusia maka %% juga mempunyai beberapa virus. Akan tetapi virus
komputer berbeda dengan virus yang menjangkit manusia, karena virus komputer merupakan
program yang dibuat untuk s program yang lainnya.
Kejadian virus pertama kali terjadi di Indonesia terjadi pada tahun 1985 peristiwa tersebut
tetjadi pada sebuzh kantor. Akibat yang timbul oleh virus tersebut adalah macet program dan
komputer. Setelah diteliti ternyata komputer tersebut telah teinfeksi oleh virus yang bernama
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Sampaisaat sekarangini kita mash disibukkan dengan virus yang bemama

HIV yang bias mengakibatkan keksbalan tubuh manusia

Seperti halnya mamisia maka % juga merpuryai beberapa vinus. Akantetapi vinus
Komputerberbeda dengan vinus yang menjangkit mansia karena virss komputer mengpakan
program yang dibuat untuk s program yanglainnya.

Kejadian vinss pertamalkaliterjadi di Indonesia terjaci paca tahun 1985, perista tersebut
terjadipada sebuahkantor. Akibat yangtimbul oleh vinss tersebut adalahmacetprogram dan
Komputer Setelah diteittemyatakorputer tersebut telahteinfeksioleh vinus yang bemanma

€ brian




image3.png
T | Virus Trojan.

3 [ MEMORY RESIDENT VIRUS
7| WEB sCRIPTING vIRUS

e
=

D TERIMAKASIH 1





image4.jpeg
Lo EEANEENECINEFTNRFIND (T SSRE IR RN TN, 55
VIRUS KOMPUTER
alam kehidupan dan komputer. Setelzh diteliti

ini terdapat beribu
visus yang dapat

‘menjangkit manusia. Sampai saat
sekarang ini kita masih
disibuickan dengan virus yang
‘bemama HIV yang bias
‘mengakibatkan kekebalan tubuh
manusia

Seperti halnya manusia maka
sempeis juga mempunyai beberapa
virus. Akan tetapi virus komputer
berbeda dengan virus yang
‘menjangkit manusia, karena virus
komputer merupakan program
‘yang dibuat untuk mevss: program
yang lainnya
Kejadian virus pertama kali
terjadi di Indonesia terjadi pada
tahun 1985. peristiwa tersebut
terjadi pada sebuah kantor.
Akibat yang timbul oleh virus
tersebut adalah macet program

ternyata komputer tersebut telah
teinfeksi oleh virus yang bemama
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Saat ini sudah ada cukup
‘banyak jenis jenis virus pada
Komputer. Virus komputer
biasanya diciptakan untuk tujuan
yang yang buruk banyak efek |
buruk yang di timbulkan oleh
virus komputer seperti
‘memperbanyak dirinya sendiri
sehingga memori hardisk dan
ram menjadi kecil. Berikut ini
‘merupakcan beberpa jenis virus
‘yang banyak berkembang
sekarang ini
1. Virus Trojan
2. virus worm
3. MEMORY RESIDENT
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